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Introduction to SPECTRAplus 
 

1 Introduction to SPECTRAplus 

SPECTRAplus has provisions for doing qualitative, standardless, and quantitative 
measurements in one integrated package. It includes a sophisticated Fundamental 
Parameter program to correct for “matrix” effects, and a flexible reporting tool for 
distributing the analytical results. 

This section provides a brief introduction to the SPECTRAplus software. It covers how to 
start the various programs that make up SPECTRAplus and gives a brief overview of the 
programs used for day-to-day “routine” operation, for standardless analysis, and for 
setting up quantitative methods. 

1.1 Starting the SPECTRAplus programs 

Two methods can be used for starting the SPECTRAplus programs. In addition to the 
methods given here, some users prefer to add the most commonly used SPECTRAplus 
icons to the Windows Quick Launch toolbar, or to the Microsoft Office toolbar. 

Method #1: Using the Spectra Plus icon on the Windows Desktop: 

 

Double-click the Spectra Plus folder on the Windows Desktop to open the 
list of shortcuts for launching the SPECTRAplus programs. 

 Double-click the icon for the desired program. 
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Method #2: Using the Windows Start button: 

 Click the Start button on the task bar. 

 Click on Programs. 

 Click on Spectra Plus. 

 Click on the icon for the desired program. 

 

1.2 Tasks That Must Always Be Running 

Two tasks must always be running for the SPECTRAplus software to function correctly. 
These are normally started automatically using the Windows Startup folder, but they can 
also be started manually using the shortcuts provided. Icons for these tasks should be 
visible on the right side of the Windows task bar as shown below. 

 

 

The first task is the Measurement program. This program handles communications 
between the SPECTRAplus software and the instrument. The icon for this program can be 
displayed in four different ways: 

 Circle is 
Black. 

Displayed when the Measurement program is first 
started. Status of instrument is not known. 

 Circle is 
Green. 

Displayed when the instrument is idle (not doing any 
measurements). 

 Circle is 
Yellow. 

Displayed when the instrument is busy measuring 
samples. 

 Circle is Red. Displayed when the instrument has a fault, or there was 
an error during a measurement. 
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The second task is the Alarm Monitor program. This program provides information on 
errors from the instrument. 

 Displayed when there are no errors. 

 Displayed when the Measurement program is not communicating with 
the instrument. 

 Displayed when an error or warning has been detected from the 
instrument. 

 

When an error has been detected from the instrument, the Alarm Monitor program 
displays a window giving information on the error and any corrective action that should 
be taken by the operator. 

 

 

SPECTRAplus always attempts to correct most errors. 
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1.3 Programs Used for Routine Analysis 

The following four programs are used by the operator for routine analysis of day-to-day 
samples. These are the only programs an operator typically needs to use. 

 

The Logon program is used to log on and log off. An Operator 
must be logged on before measurements can be started. All 
measured results are maintained in an Access database. Part of 
the information recorded in this database is the Operator who 
measured the sample. 

 

The Results Monitor program is used to display and print the 
results of measurements. This program is normally running all the 
time. Sample results are displayed, printed, and accepted or 
rejected using this program. 

 

The Loader program is used to define the samples to be 
measured, to start and stop measurements, and to monitor the 
progress of measurements. 

 

The Status program(s) are used to display a virtual view of the 
inside of your S4 system. It will be updated in real time. 

 

1.4 Programs Used for “Standardless” Analysis 

There are two programs that are used for “standardless” or semi-quantitative analysis. 
These are in addition to the programs already mentioned in Section 1.3, which are 
required to measure the samples. 

 

The MeasMethod Program is used to define a Measurement 
Method that dictates the elements and lines to measure, the 
measurement strategy, the spectrometer mode for 
measurement, etc. Several pre-defined “standardless” 
Measurement Methods are delivered with the SPECTRAplus 
software. 

 

The Evaluation Program is used to calculate sample 
composition using an interactive format. This allows the user to 
make decisions during the calculation phase that might improve 
the results. 
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1.5 Programs used for Quantitative Analysis 

One single program is used to set up quantitative methods using a set of calibration 
standards. All other required programs can be launched from this single program 
(FQUANT).  

 

The Quantification Editor, or FQUANT, is used to set up user-
defined calibrations. All functions that need to be done as part of 
this process can be carried out from this one module. It uses a 
“Windows Explorer” -type interface that guides the user through the 
setup, calibration and validation process. 

A Material is defined which specifies a list of elements or 
compounds present in the samples to be analyzed, and a list of 
Standard Materials with their concentrations for use in calibrating 
the instrument.  

A Preparation Method is defined to indicate how the samples will 
be prepared. 

A set of Standard Samples (or “Prepared Specimens”) is created 
by applying a Preparation Method to the set of Standard Samples. 

From this point on, SPECTRAplus works with the element 
composition of the Prepared Specimens, since the Prepared 
Specimens (and not the original samples) are what is actually 
measured by the instrument. 
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The following programs are normally launched from FQUANT, rather than from clicking 
their icons. 

 

 

The MeasMethod program uses the composition of 
the Standard Samples to create a Measurement 
Method, which can easily be modified by the user. 
This allows selection of the lines to measure based on 
the actual composition of the samples being 
measured, instead of the composition of the “original” 
samples. 

 

 

The MeasParameters program can be used to 
optimize measuring parameters, to select peak and 
background measurement positions, and to visualize 
spectral overlaps for the lines in the Measurement 
Method. 

 

 

The Loader program is used to measure intensities on 
the calibration standards, drift correction samples, and 
any “control” samples that will be used to validate the 
final calibration. 

 

 

The Model Setup program can be used to define an 
Evaluation Model which links the files and other 
information needed to measure and evaluate samples 
in one place. The use of an Evaluation Model is 
optional. By default, SPECTRAplus links the needed 
files by their names: 
  Measurement Method file name = 
  Calibration file name = 
  Results Format file name, etc. 

 

 

The Results Manager program is used to define the 
output format of results displayed and printed by the 
Results Monitor program. This includes options like 
output order, concentration units, number of decimals, 
etc. 

 

 

FQUANT is then used to calculate the calibration coefficients using 
“Fundamental Parameter” or “Empirical” -based mathematical 
models to correct for “matrix” effects if needed. 
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The following program can be launched from FQUANT, rather than clicking its icon. 

 

 

The Evaluation program can be used to validate 
the calibration by calculating the composition of 
“control” samples that were measured with, or after, 
the calibration samples. 

 

1.6 Additional Programs and Utilities 

 

The Specification Editor program is used to define limits and/or 
alloy specification (type standardization).  

This utility can be used to define upper and lower warning and 
alarm limits for check samples or materials. It writes the definition 
into the Specification database. 

 

The User Modules program is used to define modules which use 
the data obtained from the calibration to calculate user-defined 
values. This is to create calculations such as the Bogue clinker 
composition or other ratios.  

 

The Line Library Manager program is used to inspect and 
manage the line library. It allows the user to check for drift 
correction data, import and export lines, and copy details to the 
clipboard. 

 

The Spectrometer Alignment program is used to align the 
instrument. It realigns and sets the high voltage for the detectors, 
performs the goniometer alignment, and adjusts the peak 
positions. It is possible to start the drift correction for the 34mm 
mask size with this application. 

 

M80-E00024     2/05  1-7 



Introduction to SPECTRAplus 
 

The “Service and Utilities” folder on the desktop contains the following additional 
shortcuts. All applications mentioned above can be found by navigating to the 
\SPECPLUS\ directory on your hard disk when not stated otherwise. 

 

 

The S4Tools program (located under \SPECPLUS\S4Tools\) is 
used to monitor the hardware of the system as well as to 
troubleshoot the unit. 

 

The MeasControl program (formerly known as DIRECT 
COMMANDS) is used to communicate directly with the instrument 
using two-letter commands. 

 

The Spectrometer Configuration application manages the 
system and password configuration of SPECTRAplus and the S4 
system. 

 

The Spectra Mail application is used to extract all relevant data for 
an application from your system and databases (a .spm file) so that 
you can email them to the support hotline.  

 

The BIMSPLIT utility can divide and reassemble a .zip or .spm file 
into “chunks” so that they can fit onto a floppy diskette or make up 
email-friendly attachments. 

 

The L_WIZARD utility is used to manage the copy-protection 
license for SPECTRAplus. With this utility, you can recreate a license 
(with an emailed code) as well as check the types and number of 
licenses. 

 

The SampleDef application enables you to modify and create .def 
files used by the Loader. These .def files control the functionality of 
the Sample Edit window. 

 
The LIBMANAGER utility is used to manage and inspect the lines 
in your Line Library. 
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1.7 Fi

 

le Structure and File Locations of SPECTRAplus 

 

 

Directories in the red box (including the subdirectories) should be backed up using the 
C’s internal CD burner on a regular schedule. These directories contain the USER P

DATA. 
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1.8 Table of File Types used in SPECTRAplus  

 

File Extension Description Directory \SPECPLUS\ 
CNF Configuration file Libraries 

MDB Database file Databases 

FLL Line Library Libraries 

XRD Parameter files Libraries 

MM Measurement Methods Measmethods (also in AXS and 
Driftcorrection subdirectories) 

As a rule, user-created quantitative or 
qualitative Methods should be stored 
under \Measmethods, whereas all 
Methods pertaining to the Standardless 
Method should be stored in their 
respective AXS subdirectories 
according to the used mask size. 

WZM Query Measmethod Wizard file Measmethods 

ML Query Mapping List file Measmethods 

DEF Load r Definition File Measmethods e

RTF Rich Text Format files for merging Measmethods 
results into formatted word reports. 

MLB Module file Measmethods 

SSD Raw data file from a measurement TempSSD and Materials 

FCL and FQN Calibration files Calibrations 

EVM Evaluation Model Calibrations or Calibrations\Axs 

ERR Error log files Info 

TSV Summary Alignment files Info 

LOG Application Log files Info 

STS Service Tools Status files S4Tools 

EXE Executables SPECPLUS 

Others Internal System files SPECPLUS 
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1.9 Recommended Settings for Windows 

The following folder options are recommended when using the Explorer to navigate in 

1. Within Wind elect the Tools

2. Select “Folder Options”. 

3. Select and inspect the General tab. 

Windows: 

ows Explorer, s  menu. 

 

4. Select the View tab. 

 

5. Make sure to select “View Details”. 
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2 Standardless Program 

This section covers the Standardless Program that is part of the SPECTRAplus software.  
The Standardless Program enables virtually any sample to be quickly analyzed, and an 
estimated composition calculated from the data. It is most useful for samples that are 
encountered infrequently in the laboratory, where calibration standards may not be 
available. Even if standards are available, the total number of samples to be measured 
may not warrant the effort to make a specific calibration. It is also referred to as a 
universal calibration. 

 

2.1 Using the Standardless Program 

Measuring “Unknown” Samples Using a Standardless Method 

Making a “standardless” measurement on a sample is no different than making a 
“normal” measurement on a sample. The only requirement is that the Measurement 
Method selected to measure the sample contains a selection of “pre-calibrated” lines 
from the Line Library, since these are required to calculate the sample composition. In 
order to separate standardless Methods from quantitative Methods we use different 
Loader definition files, which will show us only the standardless Methods for a given 
mask size. 

 

Run the Loader program. 

 

Clear any samples, if necessary, using the icons “Clear New”, “Clear Error” 
and “Clear Done”. 

 
Click View on the menu, and check the options as shown below (all options 
are checked). 
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Arrange the windows as shown, or to your own preferences. 

 

 

To use the provided standardless Methods, please use the following definition files: 

34mm mask AXS-34 

28mm mask AXS-28 

18mm mask AXS-18 

23mm mask AXS-23 

08mm mask AXS-08 
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mples→Definition File 
 

If the “AXS-34” tab is not shown, select Sa
from the menu. 

 Click the drop-down arrow in the “Look in” box. 

 

Make sure the “\SPECplus\Libraries\MeasMethods” folder is 
selected. 

 

 Select “AXS-34”. 

 Click the Open button. 

 Click on the “AXS-34” tab to select it. 

 

Right-click on the sample position where the first 
sample is loaded. 

 Click on the Edit Sample button. 
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LAS 404  
Type the name for this sample in the Sample column, then press the 
<Tab> key. 

 

 

Fast-Vac34 Select one of the displayed Methods with which to measure 
this sample (Fast-VAC34). 
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 Click in the Evaluation box to open the drop-down list. 

 Select “Elements” as the type for this sample. 
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 Click in the Preparation box to open the drop-down list. 

 Select “Solid” as the preparation for this sample. 

 

 

 Click in the Type box to open the drop-down list. 

 Select “Bulk” as the type for this sample. 
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Additional fields for weight of sample (in g) and weight of additive (in g) are included in 
the newer Def files for AXS*. They will be pre-filled with the default value for the 
preparation. 

 
Click the “Send All Samples” icon to start the 
measurement. 

 

Once the sample has been loaded, the measurement will start.  This is 
indicated by the blue circle with the moving dots seen on the sample holder. 
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The Sample f ple (line being 
measured, time left, etc.). 

The Sample List window shows the current sample queue. 

The Results window will show the results based on the automatic evaluation of the 
selected sample. 

InIn o window will show the current status of the selected samo window will show the current status of the selected sam

2-8 

o

Standardless Program 
 

2-8 

The Sample f ple (line being 
measured, time left, etc.). 

The Sample List window shows the current sample queue. 

The Results window will show the results based on the automatic evaluation of the 
selected sample. 

o
InfInf
  

t
Lis
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Select the Status display from the SPECTRAplus folder on the desktop and 
follow the measurement “online”. 

 

 

 

 

Close the Status display when done and switch back to the Loader. 
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When the measurement of the sample has completed, the sample holder 
should have an “OK” displayed on it. 

 

 

 

 

Click on the sample and observe the Results View of your Loader screen. 

 Use the navigation bar to slide to  right to see all the automatically-found 
elements and their concentrations. 

 the
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.2 Calculating Standardless Results for an Unknown Sample 

 

This section covers the interactive evaluation of a sample’s composition using the 
SPECTRAplus software. It uses the data from a “low-alloy steel” sample measured with 
the Standardless Measurement Method described in Section 2.3, and measured as 
outlined in Section 2.1. As you work through this example, your results will be different 
than those shown because your results are based on a different measurement of the 
sample, and a different drift correction of the Standardless Program. Nonetheless, the 
concepts presented can be used with any similar set of data. 

2

 
Run the Evaluation program. 

 Make sure the Filter Peaks box is checked.  

 Click the “Next SSD File” icon. 
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Set the Search Control to when t
 

he sample was measured (e.g., 
“Today”, “Yesterday”, etc.). 

LAS 404 Highlight the sample name “LAS 404”. 

 Click the Open button. 

 

 

 Click the Evaluate Sample button. 
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Ma Aplus to 
recalculate the sample composition as changes are made to the assumptions 
about this sample. 

ke sure the Auto Update box is checked. This will tell SPECTR

 Click the “Eyeglass” icon. 
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 Click the Reset button. 

 
Highlight “Delta”, “Imbalance”, and “Prepared Elt.” by clicking o
one, then holding the <Ctrl>

n 
 key down while clicking on the others. 

 Click the Remove button. 

 

 

Highlight “Line 3”, “Concentr. 3”, “Stat. Dev. 3” and “Depth 3”. The 
Measurement Method used to measure the sample measured a maximum 
of two lines. 

 Click the Remove button. 
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 Highlight “Raw Int 3” and “Bkg 3”.  

 Click the Remove button. 

 

 

 Click the OK button. 

 

 

Click the “Save as Default” button to save these settings as the default. 

The calculated composition for this sample should now be listed as shown below. 
The columns have the following meanings: 
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 - Comp und F lement or compound name. 

 - nZ  

 - Conce tratio centration for each element or compound 
listed. 

 

Note that sorting can be done on any displayed column by clicking on the column header 
which toggles between a forward and reverse sort of the data. 

 

o ormula The reported e

The atomic number of the reported element, or key element
from a compound. 

n n The reported con
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For up to 3 measured lines, the following information is displayed for each line: 

 

 - Line n The name of the line measured. 

 - Concentr. n The concentration calculated from the intensity of the measured line. 

 - Stat. Dev. n The error in the concentration from counting statistics for the 
measured line. 
This is an indication of the reproducibility, not the accuracy, of the 
results. 

 - Depth n The estimated depth in the sample where 90% of the measured 

 

 

radiation is coming from (“effective layer depth”). 
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SPECTRAplus uses filters to display only significant 
concentrations calculated from a sample. 
T

- 
intensity must be above the background 
intensity in order to have its calculated 
concentration displayed. This prevents 

icant peaks. 

- Con. > Sets an absolute concentration threshold that 
must be exceeded before a calculated 
concentration is displayed. This can be used to 
limit the display of concentrations to only 
significant values. 

- Experiment with these controls to see what effect they have on the displayed 
concentrations. 

- When you have finished, reset them as shown in the diagram below. 

he following two filters are used: 

 Intensity > Sets how many standard deviations a peak 

displaying concentrations for elements that 
have statistically insignif
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The sum of the concentrations is displayed in the Total box.  The 
closer this sum is to 100%, the more confidence one can ha
th

ve in 
e calculated results. 

 

 

 Click the Optimize icon to normalize the concentrations to 100%. 
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The ation factor will be 
disp

 

 total should now be 100%, and a normaliz
layed in the Norm. Fact. box. 

 

 
Click the Reset icon to reset the “Normalization Factor” to one and 
recalculated the co

 

At this point, we will start making decisions about how the sample composition will be 
alculated. If these decis h the

results, and if these decisions do not m lts obtained 
will be questionable. 

If any compositional information is know e, it should be entered to 
improve the calculated composition. For example, this sample has 0.67% Carbon. 

ncentrations. 

c ions matc  “reality” of the sample we should obtain good 
atch the “reality” of the sample the resu

n about this sampl

 

 Click the Insert Compound button. 

 Type “C” in the Formula box. 

 Type the concentration for carbon (“0.67”) in the Fixed box. 

 Click the OK button. 

 

The concentration for Carbon has now been fixed to 0.67%, and it is displayed in red to 
indicate this. 

All concentrations that are calculated by the SPECTRAplus software should be verified by 
the user to ensure that they should be reported. This is easiest when the data has been 
measured as scans, which is the case for this sample. The measured spectra can be 
viewed on the screen to ensure that a peak can be seen, and that the peak is from the 
element in question and not from some other element present in the sample. 
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 Click the “Toggle Line 1” icon to open a small window for viewing the spectra. 

Manual Element 
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Tb Click on  low 
concen

the “Tb” line to highlight it (or click on one of the other lines with a
ation). tr

Click the pdate button in the View window to display the intensity data for 
Terbium. 

U
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 Make sure the Zoom Peak and Peak Only boxes are checked. 

 This is the spectra for the “Tb-LA1-HS-Min” line, it does not look like a 
peak is really present. 

Note that when the mouse pointer is moved over the data, a list of lines 
near the mouse pointer is displayed in the upper right corner of the View 
window. 

Tb LB1-HS-Min Click on the “Tb-LB1-HS-Min” line to view its spectra. 

 

Lines near mouse pointer, 
useful for identifying peaks. 

 

 This is the spectra for the “Tb-LB1-HS-Min” line; it does not look like a peak is 
really present either. 

 Click the Push Pin icon to set this concentration to zero. 
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 Display the spectra for Holmium (“Ho”): 

 Click on the “Ho” line to highlight it. 

 Click the Update button in the View window to display the intensity data for 
Holmium. 

 There is no apparent peak. 

 

Ho LB1- 

HS-Min 

Click on the “Ho LB1-HS-Min” line to see if it is more usable. 
 

 Click the Push Pin icon to set this concentration to zero. 

 Close the View window by clicking the X in the upper right corner. 
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Ni KB1 
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 A “low-alloy steel” sample contains mainly Iron (Fe), or in other words, the 
matrix element is Iron. Since SPECTRAplus has calculated too high a 
concentration for Fe in this sample (105.6% in this example), it would be better 
to have Fe calculated as the matrix element. 

 Click the Matrix button. 

 

 Enter “Fe” in the Formula box. 

 Click the OK button. 

 

Or right-click on Fe and select Matrix. 
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Iron (Fe) is now calculated as the Matrix or “Balance” element, and its concentration is 
isplayed in blue to indicate this. 

Other elements may now appear, like Terbium (Tb) in this example. This is because 
changing the concentration for any element changes the whole sample composition.  
We can view the spectra for any new elements that have appeared, and if desired, 
eliminate them with the Push Pin icon as done before. 

d
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Matrix Element 

Extra Element 

 

 Once we are satisfied with the results, we can print and save them. 

 Click the Print Result button to print the sample composition. 

 Click the “--> Data Base” button to write the sample composition to the 
ieval with the Results Monitor or Manager 

programs. 

 

Measure database for later retr
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2.3 Creating and Modifying Standardless Measurement Methods 

 

Several default Standardless Measurement Methods are delivered with the SPECTRAplus 
software.   

A user has the option of defining specialized Standardless Measurement Methods that 
are more suited to his needs, e.g., reducing the number of elements measured, 
selecting the lines to be measured, and setting the counting times for the lines 
measured. If nothing else, the user should check the Mask and Counting Times of the 
supplied programs to ensure that these are suitable for his samples. 

 

 
Run the Measurement Method program. 

 Click the File Open icon. 

 Click the drop-down control in the “Look In” box. 

 Navigate to the “\SPECplus\Libraries\MeasMethods\AXS34” folder for 
methods based on 34mm. 

Fast-Vac34 Select one of the existing Standardless Measurement Methods to use as 
a template, like “Fast Vac34”. 

 Click the Open button. 

NOTE: If you get the message “some lines were not found in the library”
only means that some of the lines in the Measurement Method cannot
measured on your instrument because of  

, it 
 be 

hardware limitations (crystal, 
collimator, etc.). This message can be ignored, and the OK button clicked 
to close the error window. 
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 Click the Parameters tab to select it. 

 On this tab you can set: 

Spectrometer mode (vacuum, helium, etc.) 

Sample rotation (off or on) 

Collimator mask size 

Default measurement sequence  

 If nothing else, ensure that the correct Mode and Mask are being used for 
the samples you intend to measure with this program. 

 

 C

 This tab shows which elements have been selected for the Measurement 
Method, regardless of whether or not the element is actually measured. 

Elements can be removed from the Measurement Method by clicking on 
the appropriate element symbol to turn it gray. 

 

lick the Elements tab to select it. 
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Click the Lines Selection tab to select it. 
 
This tab can be used to force SPECTRAplus to re-select the lines to  
measure. Proceed as below ONLY TO RE-SELECT THE LINES 
BEING MEASURED. 

 Select the “Use precalibrated lines” button. 

 
Check “Reset All” to force all lines to be re-selected, leave 
unchecked to only re-select the lines for any new element
were added. 

s that 

 
Click the Apply button to apply the changes you made. 

 

 

 

 
Click on the Modes/Time tab. 

 

 can be set: 
   - Measurement mode: Scans or Fixed-Points (Scans is the default). 

Both of these settings can be made on a “Global” basis, which applies 
ocal” basis, which applies only to select lines.  

plus

 

 

On this tab the following

   - Measurement time (10 seconds is a good time to use). 

to all lines, or on a “L
See the SPECTRA  Reference Manual (M84-Exx025) for more 
detailed information. 
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 Click on the Lines tab. 

 This tab can be used to add and remove specific lines from the 
Measurement Method. Lines on the left side will be measured, and lines 

 measured. 

e right (non-measured) to the left (measured) 

easured) to the right (non-measured) 

easurement 
Method, since these are the only lines from which concentrations can be 
calculated. 

 

on the right side are available but will not be

Lines can be moved from th
with the Add button. 

Lines can be moved from the left (m
with the Remove button. 

The “(C)” after a line name indicates a pre-calibrated line. Only pre-
calibrated lines should be chosen for a Standardless M

 Click on the Recalibration tab. 

 This tab contains information on the drift correction of the Standardless 
Program. For the default library lines, this information can be viewed by 
the user, but not modified because it is protected from changes. 

 

 Use File→Save As to save any changes that were made under a different file 
name. 

 

 It is sugges nclude some form of coding with at 
least the type of lines, the measurement mod , the mask size, and the counting 
times for c
sample is m
the High Sensitivity lines and will be done in a vacuum path. In addition, the samples 
should be r 
10 second

As an exercise, create a method based on Fast Vac34 selecting only the elements 
which are present in the LAS sample (see wooden box inside the lid) using 34mm, 
scan, 10 sec time. 

Save this method as LAS check (You will need this next). 

ted that the name selected should i
e

larity, such as “st-less-HS-Vac-34mm-10s-scan”. It is clear that, when a 
easured using this Measurement Method, the measurements will involve 

loaded into 34 mm sample holders, and that each line will be measured fo
s. 
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2.4 Using the “ ss Drift Correction 

 

The “STG-2” glass sample can be measured as a control sample that can ch
effectiveness of the Standardless

Select the Loader

Load the efinition fil

Click on the “STG2” tab on the bottom of the Sample Edit window. 

Click the position on the Loader where you placed the STG2 sample in a 34mm cup. 

Type in “STG Test” as the sample name; the rest will be automatically filled in when 
sing the STG2 def file.  

therwise, measure it by using the AXS-34 def file (older versions of SPECTRAplus or 
units shipped before Jan 2004). Choose the STG-check.mm and the STG-check evm 

odel) with solid as a preparation. 

STG-2” Sample to Check the Standardle

eck the 
 drift correction just performed. 

. 

 d e STG2.def for the STG check. 

u

O

(m

 
Figure 1 - Loader Screen with STG Check Def and Sample 

Start the sample by selecting “Send Selected Sample” or by pressing the F10 key. 

The sample locks down and will start measuring. 
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Figure 2 - STG ch

When the sam  
Aplus 1.6.6, it is possible to view the results of the measurement in a separate 

indow pane (See Figure 3). 

eck running 

ple displays with a yellow OK tag, the measurement is finished. In
SPECTR
w

 
Figure 3 - STG check done with results displayed in LOADER 
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Select the Results Monitor. 

Select File→New Monitoring View. 

 
Figure 4 - Results Monitor with STG check results 

Select STG Check from the drop-down window as a report format (red oval in Figure 4). 
Press Update (red arrow) and highlight the entry with the current measurement. 

Select Print Results (red square in Figure 4). This will print the results on the default 
printer.  

Check the concentrations in the printout and compare them with the concentration on 
the measurement obtained at the installation on your site. 

If any of the concentrations are NOT within the prescribed limits, it is necessary to drift 
correct the Standardless Method, and if this fails, to perform the alignment of the unit. 
After the drift correction is performed, the STG measurement has to be repeated to 
validate the positive outcome. 
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To interactively evaluate the STG measurement: 

 
Run the Evaluation Program. 

 Click the Next SSD File icon. 

 

 
Set the Search Control to when the sample was measured (e.g., 
“Today”, “Yesterday”, etc.) 

 Highlight the sample name. 

 Click the Open button. 

 Click the Gears icon to ensure that the sample results are calculated. 

 

 Make sure that “Compounds” is selected. 

 Make sure that “Original” is selected. 
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2.5 Drift Correction of the Standardless Program 

he Standardless Program, the user must measure 
some drift correction samples on his instrument to adjust for the sensitivity of his 
instrument. These drift corrections must be performed in every Mode and Mask 
combination that will be used to measure unknown samples. This guide details making 
the drift corrections for samples measured in a vacuum path with a 34mm sample 
holder, but other Mode/Mask combinations are measured in a similar fashion. 

 

Prior to measuring any samples with t

 
Start the Loader. 

 Click View in the menu, and make sure all options are checked. 

 Arrange the Edit, Info, and View windows as shown, or to suit your 
tastes (see Section 2.1). 
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Select Samples→Definition File… from the menu. 

 

 

 Click the drop-down arrow in the “Look in” box. 

 

Make sure the “\SPECplus\Libraries\MeasMethods” folder is 
selected. 
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 Select “S4-RECALxx.def”, where xx = Mask size. 

 Click the Open button. 

 

 Click on the S4-RECAL34 tab to select it. 

 
Right-click on the sample position where the first sample is loaded. 

 Click on Edit Sample. 

 

 Select “S4-RECAL-SQ1-Vac34” from the list of samples. 
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 all 5 or 6 have been 
selected: 

 
S4-RECAL-SQ1-Vac34 
S4-RECAL-SQ2-Vac34 
S4-RECAL-SQ3-Vac34 
S4-RECAL-GRA-Vac34 
S4-RECAL-STG-Vac34 

 

Optionally “S4-RECAL-BN-Vac34” (only for OVO-B or 
OVO-N crystal) 

Continue selecting samples until

 

 

 
Click the Send All Samples icon to start the measurements. 
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As eac  s is indicates that 
the drift correction was successful. 

h ample finishes, it should display “OK” on its cup. Th
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If any of the sample holders have a Red X on them, this indicates that the 
drift correction failed. 

There will also should be an error window open which lists the cause of 
failure: 
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To obtain more specific information on the error, run the Windows 
Notepad program. 

 
Click on File→Open. 

 

 

 Click the drop-down control in the “Look in” box. 

 

Navigate to the “\SPECplus\Data Files\Info” folder. 
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tEvl.log” file. Click on the “Quan

 Click the Open button. 

 

 

 Press the <Ctrl> + <End> keys to move to the bottom of the file (or use the scroll 
bar on right side of window). 

Error  
Message 
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3 Quantification Program 

This section covers the Quantification Program that is part of the SPECTRAplus software. 
It is based on an example using a set of five “Low-Alloy Steel” samples to cover the 
entire calibration and analysis of unknown samples using the SPECTRAplus software. 

3.1 Introduction to the Quantification Program (FQuant) 

 

Click the Quantification Editor icon to start the FQuant 
program. 

 If you set an “Access Rights” password in FQuant, to gain 
access: 

 
Click Settings→Access Rights on the menu. 
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can be used to navigate by clicking on one of the listed functions
using the mouse. The Next and Back buttons in the lower r
corner can also be used to move between functions in a 

The document window is split into two parts: 

The left side of the window has an “Explorer-type” interface that 
 

ight 

sequential manner. This is the most foolproof means of using the 
 are carried out in the 

correct sequence and that nothing is missed. 

sly 
 information and provides the opportunity to define new 

information, or to change existing information. 

 Some of the functions listed in the “Explorer” window are 

selected, the right side of the window displays: 
  Please push “Next” button 

 

software since it ensures that all functions

The right side of the window is used to display previou
defined

 

placeholders, and require no input. When one of these is 

  The main options in the “Explorer” window can be expanded and 
collapsed using the “[+]” or “[-]” symbols for the desired function. 

 

 

 

This side of the 
screen is used for 
navigation. 

Information is entered 
and modified on this 
side of the screen. 

Navigation Buttons: 

M80-E00024     2/05  3-3 



Quantification Program 
 

The general co lopment of a 
new analytical method into logical steps, 
closely as possible during each step. Briefly, these steps are as follows: 

 

Materials: Is used to define what we are trying to analyze. It is also used to 
define any other materials that might be used in the preparation of 
the XRF specimens such as binders, fluxes and cup-closing foils. 

Preparation: Is used to define exactly how the XRF specimens were prepared. 

Standard 
Samples: 

Is used to define “prepared” XRF specimens by applying a 
Preparation to a Material. In this way, the true composition of the 
specimen being measured by the XRF instrument is known. 

e  Method that can be used to 
s. It is also used to optimize the 

measurement conditions, and to measure the set of calibration 
standards. 

Evaluation 
Model: 

Is optional. By default, SPECTRAplus expects all parts of an Analytical 
Method to have the same name. This includes the Measurement 
Method used to measure the intensities, the Fluorescence 
Calculation List used to calculate the concentrations, and the Results 
Formatting file used to control the display and output of the results. 
One use of an Evaluation Model is to specify the names for each part 
of the Analytical Method so that the individual parts do not have to 
have the same names. 

Results 
Formatting: 

Is used to define how to report the results to the screen and the 
printer. This includes order of output, concentration units, number of 
decimals, etc. 

Calibration: Is used to calculate the calibration coefficients and then save these 
into a Fluorescence Calculation List. SPECTRAplus has an integrated 
Fundamental Parameters program for handling matrix effects. 

Interactive 
      Evaluation: 

Can be used to recalculate the composition of a control sample or 
calibration standard to allow fine-tuning of the calibration curve. 

 

ncept of the SPECTRAplus software is to break down the deve
with the X-ray physics being modeled as 

M asurement: Is used to define a Measurement
measure intensities from the sample
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Click the Next button twice to move to Mate
  

rials. 

 

Material Group 
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In SPECTRAplus, a Material is any physical thing used in the laboratory for measurements 
by the XRF instrument. These materials include the samples to be analyzed, additi
used to prepare the XRF specimens for measurement, contaminates pick

ves 
ed up by 

amples during their preparation, and cup-closing foils placed on plastic cells when 
advantage to this approach is that all of 

the e defin
actual material to be a

SPECTRAplus uses Material Groups to keep the list of materials logically arranged. The 
use ew M
Material Groups that are used for the following purposes: 

 

Additive: 
ts. 

Contamination:  

les 

Tutorial: 

n 

 

s
measuring liquid or loose powder samples. The 

se things ar ed the same way. This means that to define a binder, foil, or an 
nalyzed, one would use the same steps and the same “tools”. 

r can define n aterial Groups to meet his specific needs. There are four special 

Anything added to samples during their preparation must be defined 
in this Material Group. These include binders, fluxes and diluen

All contaminates picked up by samples during their preparation must
be defined in this Material Group. For example, powdered samples 
can pick up tungsten carbide when they are ground in a tungsten 
carbide grinding vessel. 

All cup-closing foils used to prepare liquid and loose powder samp
must be defined in this Material Group. 

This Material Group contains example materials used in the 
SPECTRAplus Tutorial Manual (M84-Exx030). This allows one to learn 
how to use the software without making any actual measurements o
their instrument. 

Foils: 
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 Select the Additi e in the Material 
Group box. 

v Material Group by clicking the drop-down control 

 Select the Tutorial Material Group by clicking the drop-down control in the Material 
Group box. 

This shows the list of pre-defined materials that are used in the SPECTRAplus Tutorial 
Manual (M84-Exx030). 
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3.2 Defining a New Material 

In this section, a new Material for Low-Alloy Steels will be added to the “Training” 
Material Group. 

 

 window. 
Make sure that Materials is highlighted in the “Explorer” 

 Make sure the Tutorial Material Group is selected. 

 Type “LAS-Example” as the new Material name. 

 Click the “New Material” icon, or press the <Enter> key. 
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 Click the Next button to move to the Elements Oriented screen. 

 The Elements Oriented screen can be used to define the elements or 

bol on the periodic table. 
oxides present in a Material by simply clicking the appropriate element 
sym

 Before each element symbol is selected, its Type can be ch sen using
the Elem

o  
ent or Oxide buttons at the bottom of the window. 

ince only elements and some pre-selected oxides can be defined using the Elements 
Oriented screen, SPECTRAplus also provides a Compounds Oriented screen for entering 
more exotic compounds. 

 

When specifying what is in our Material we must at least define: 

All elements that are to be determined by XRF (measured). 

All elements or compounds that will have manual input of their concentrations 
(concentrations given when the sample is measured). 

Any single element that is to be determined as the balance to 100%. 

If the Fundamental Parameters portion of the SPECTRAplus software will be used to 
correct for matrix effects, then enough elements and/or compounds must be defined to 
enable definition of 98 to 100 percent of the sample composition. 

In this example Cr, Mn and Ni will be determined by XRF, and Fe will be determined as 
the “balance” element:  Fe = 100% - (%Cr + %Mn + %Ni) 

 

S

 Make sure the Element button has been selected. 

    Click Cr, Mn, Fe, and Ni on the periodic table to add these elements 
to the “LAS-Example” material. 

  Click the Next button twice to go to the Standard Materials screen. 
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In the next steps, a list of Standard Materials or “calibration standards” will be defined 
along with their compositions. This list will ultimately be used to calibrate the XRF 
instrument for analyzing these types of Materials. 
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 Type the name of the first calibration standard (“SS 401”) in the 
New Standard Material box. 

 Click the New icon or the enter key to add this name to the list of 

 

Standard Materials. DO NOT USE symbols such as /?$&:, or 
leading and trailing blanks.  

 

“SS 401” has been added to the list of “Standard Materials”. 

Continue to enter the names for each of the five calibration standards: 
“SS 401”,

 

 “SS 402”, “SS 403”, “SS 404” and “SS 405”. 

 Click the New icon after each name has been entered. 
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If a mistake is made when entering the names, this can be corrected by: 

Select std to Click on the name of the stand
delete 

ard entered in error until its row is 
highlighted. 

 Click the Delete icon. 
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 Click the Yes in the warning window to delete this standard. 

 

 

Once the names for all the calibration standards have been entered, the next step will 
be to set the display format for each element. In this example all element concentrations 
are in weight-% and will use 3 fixed decimal places, so the format for all elements can 
be set at once instead of setting them individually. 

Left-click anywhere in the white cell area to select it. 
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 Left-click the first cell, hold down the left mouse button and 
drag the mouse to highlight one row across all the columns. It 
doesn’t matter which row is selected. 
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Right-click any of the highlighted cells. 
Select Unit, then % from the pop-up menus. 
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 Make sure that one row is still highlighted; if not, re-select one 
row. 

  

 

 

Right-click on any of the highlighted cells. 
Select Column Decimals, then 3 from the pop-up menus. 
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 Left-click on the first cell to select it for input. 
 

 are set to “T” for “Trace”. This 
n, but is assumed to be 

close to zero. 

Note that initially all concentrations
means that the concentration is not know

 Use the Bottom and Right buttons to control in which direction the 
next cell will be selected after pressing the <Enter> key. 
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Enter the concentration values given in Table 1 into this form 
or use the values from the box of your installation standards, 
e.g., SS XXX/3. 

 
 
Do not enter any values for Fe at this time.

 

Standard Cr(%) Mn(%) Fe(%) Ni(%) 

SS 401 0.08 1.00 Bal 0.02 

SS 402 0.55 0.19 Bal 0.73 

SS 403 0.42 1.69 Bal 0.24 

SS 404 0.68 0.52 Bal 0.46 

SS 405 0.21 1.28 Bal 0.12 

Table 1 - Concentration values for the LAS calibration standards (these are for LOT 0! 
Use the ones from your BOX!) 
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 Type a “b” for one of the concentration value
th
 
This indicates to SPECTRAplus that Fe will be calculated as the 
“balance” elem

s for Fe, then press 
e <Enter> key. 

ent instead of being measured by XRF like the other 
elements. 
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The column for Fe should
the “balance” or “matrix” e

 

 now be displayed in yellow, which indicates that Fe is 
lement. 
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Some mes approxi s are 
not certified. SPEC ing these uncertified concentration values as 
“inaccurate”. 

To flag a concentra

ti mate concentrations are known for some elements, but these value
TRAplus allows flagg

tion value as inaccurate: 

 Right-click on the value and select Inaccurate from the pop-up menu. 
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 Concentration values declared as inaccurate are displayed with a line drawn 
through them. 

y of the concentrations to “inaccurate”, reset them 
before proceeding. 
NOTE: If you have set an

 

 

 Click the Next button to go to Preparation. 

 Click the Yes button to save the changes that were made in the calibration 
database (\SPECplus\Databases\Fluo.mdb). 
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3.3 Defining Specimen Preparation 

 

Preparation is used to define how specimen
XRF Instrument. This will allow SPECTRAplus

s were prepared for measurement by the 
 to know the “true” composition of a 

prepare  ften 
not the same as the original sample. 

On this screen we can select one of the SPECTRAplus pre-defined preparation methods, 
or define our own preparation methods. 

Defining a new preparation method is covered in the SPECTRAplus Tutorial Manual, but 
briefly it involves the following steps: 

1. Type a name in the Preparation field, and click the New icon. 

2. Select the method of preparation (Fused Bead, Pressed Pellet, etc.) 

3. If anything was added to the sample (binder, flux, etc.) select this in the 
“Addition” field. Note: Only Materials from the special Material Group named 
“Additives” can be selected here. 

4. Define the weights or ratios of the original Material and any added 
compound. 

d specimen. This is important since the measured sample (specimen) is o
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In this example, the specimens were prepared as “Solid” samples with nothing added. 

 Click the drop-down control for Preparation and select Solid as the 
Preparation. 

 Click the Next button to move to Size. 
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Size s entering an Area Density param allow eter for the prepared specimens. 
his will allow SPECTRAplus to correct the intensities for samples that may not 

 thick to the X-rays being measured. 
T
be infinitely

In this example, the samples are infinitely thick. 

 Click the Next button to move to “Contamination”. 
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Contamination involves selecting a Material from the “Contamination” Material 
Group, and specifying the percent of this contaminate being picked up by a 
sa ple du

This is also where a “blank” sample can be declared. 

See the SPECTRAplus Reference Manual (M84-Exx025) for more information on 
is topic. 

In this example, the samples are not contaminated during the preparation 
phase. 

m ring its preparation. 

th

 Click the Next button to move to Foil. 
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Foil allows selecting a Material from the “Foils” Material Group, and specifying
the Area Density of this foil. This allows SPECTRAplus to adjust the measured 
intensities for their absorption by this foil. 

 

xx025) for more information on 
this topic. 

In this example, the samples are not covered with a foil. 

See the SPECTRAplus Reference Manual (M84-E

 Click the Next button to move to Standard Samples. 
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3.4 Creating Standard Samples 

ared 
 

llows a conversion of the concentrations in the Standard 
Materials to concentrations in the Standard Samples (or “Prepared Specimens”). The 

 Specimens”) will include any 

plus

This step is important for many

ities from the elements in the prepared 
pecimen, not from compounds in the original material, although in some cases these 

may in fact be the same. 

SPECTRAplus can make intelligent choices when selecting X-ray lines to measure in later 
steps, because it can base its selection on the concentration of each element in the 
prepared specimen instead of in the original material. 

In order for the Fundamental Parameter-based matrix corrections to work properly, 
SPECTRAplus needs to know the composition of the specimen that is actually being 
measured by the XRF instrument. 

The primary purpose of this step is to create a set of Standard Samples (or “Prep
Specimens”) by applying a Preparation Method to the Standard Materials (or
“Calibration Standards”). This a

concentrations in the Standard Samples (or “Prepared
Additives and Contaminates that have been declared under “Preparation”, and will be 
minus any volatiles if the Preparation Method indicates a “Fused” sample. 

From this point on, SPECTRA  will use the “elemental concentrations” on a “prepared 
specimen” basis. 

 reasons, including the following: 

The XRF instrument is measuring intens
s
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 Make sure “Short names” is checked. This keeps the Standard 
Sample name the same as the Standard Material name. 

 Make sure “All preparations” is un-checked. This will only sho
Standard Samples prepar

w 
ed as “Solid”. 

 Make sure “All standard materials” is checked. This shows 
Standard Samples for all Standard Material names, not just the 
Standard Material currently selected. 

 Click the Automatically create all 
Standard Samples button. 

 

3
2

1 
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The list of Standard Samples has now been created. 

 Click Next twice to go to Measurement Method.  
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3.5 Creati

 

In this step, a fo  created. This defines which 
intensities to measure, and which spectrometer conditions to use when making these 
measurements. 

 

ng a Measurement Method 

rmal Measurement Method (*.mm) will be

 Click the Edit Measu em
Measurement Method pr

r ent Method button to start the 
ogram. 
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SPECTRAplus has already done most of the work. 

For the  measu ere 13 
possible lines in the Line Library of the system used here that could have 
been used to characterize the 3 elements. Of these 13 lines, SPECTRAplus 
chose 3 lines, one for each element. 

3 red elements in our program (Ni, Cr and Mn) there w
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 Click on the Parameters tab to select it. 

 The “Vacuum” radio button should be selected under “Spectrometer 
mode”. 

 The “Fixed speed” radio button should be selected under “Sample rotatio
. . .

n 
” 

 The “Mask” size radio button should be selected under “Collimator mask . 
. .” to match the sample holders being used. 

 The “High energy lines first” radio button should be selected under 
“Measurement order”. 
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 Click on the Elements tab to select it. There is nothing to do here, but the 
following should be noted: 

The measured elements (Cr, Mn and Ni) were automatically transferred 

” element in 

(The column color was yellow in “Standard Materials”). 

from the Material defined in FQuant. 

Fe was not transferred because it was declared as the “balance
FQuant. 
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In the ext ste ct the 
lines that are to be measured. SPECTRAplus includes a complete Line Library with nearly 
all XRF lines already defined. Most lines have high resolution (HR) and high sensitivity 
(HS) ve ions
lines are further classified into “Major” (Maj), “Trace” (Tra) and “Minor” (Min) categories. 
This allows SPECT plus

best tensity
specimen (ma  are added to our 
Measureme e 
original line with the Material name appended to
of the Library Lines allows modification to the measurement conditions and independent 
drift correction of the lines selected. 

 n p, we will make choices indicating how we want SPECTRAplus to sele

rs  defined, provided the hardware in the instrument supports these. Some 

RA  to select lines based on the major category (best resolution or 
), and then by the concentration level of each element in the prepared 
jor, minor or trace). When these Library Lines

in

nt Method they can be added directly (the line itself) or as a copy of th
 the end of the line name. Using copies 

M80-E00024     2/05  3-35 



Quantification Program 
 

Click on the Lines Selection tab to select it.  

 

Select the “Create Specific lines” radio button. 

n “LAS-Example” appended to the 
end of the line name. Because these are now separate lines in the Line 

ed to make them optimal for these samples without affecting the 

 
Enter the names of the Recalibration Samples or Drift Samples. 
They were chosen because they will provide a reasonable low and high 
intensity for the three elements being measured. 

This will give us an exact copy of the selected lines from the Line 
Library, except with the designatio

Library, the measurement conditions used for these lines can be 
modifi
other lines in the Line Library. 

 
Select the “One Line” radio button. 
This will cause only one line to be selected for each element. 
SPECTRAplus can select up to 3 lines per element. 

 
Select the “Highest Intensity” radio button. 
This will cause the “HS” (high sensitivity) lines to be selected from the 
Line Library. 

 
Select the “Thick sample/high energy lines” radio button. 
This will cause K-lines to be selected instead of L-lines. 

 

Uncheck the boxes to measure extra lines. 
These allow tube scatter lines and matrix element lines to be measured. 

 
Check the box to “Reset All” lines in the Measurement Method. 
This will apply our selections to all the elements in our Measurement 
Method. 

 
Click the Apply button to apply these selections to the Measurement 
Method. 
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In the next step PECTRAplus to measure 
the intensities f  
measure the in e. 
These choic s 
Method, or to “L

For this examp g fixed peak and fixed background 
positions. A counting time of 10 seconds will be used at each peak angle, and the same 
amount of time

, we will make choices indicating how we want S
rom the lines that were selected. These choices include whether to
tensities as “scans” or at “fixed positions”, and the counting times to us
can be set as “Global”, so they apply to all lines in the Measurement 
ocal”, so they apply to certain lines. 

le, we will measure all lines usin

e

 will be used at each of the background angles. 

 Click on the Modes/Time tab to select it. 

 Select the “Global parameters f
All lines will be measured the same. 

or method” radio button. 

Make sure the Measure at fixed Positions button is pressed in 
“Peak Measurements” and “Backgroun
All intensities will be measured using fixed positions. 

d Measurements”.  

Make sure the button for “Run scan measurements” is not pressed 
ents”. in “Peak Measurements” and “Background Measurem

No scan-based measurements will be made. 
 

Select the “Fixed” radio button in “Meas
All measurements will used fixed counting times, instead of counting 
to a set statistical error. 

uring Time”. 
 

Select “30 s” as the counting “Time for Peak”. 
Intensities will be measured for 30 seconds at each peak angle.  

Select “Each” for the “Background(s)”. 

round measurement time equally between each background 
position. 

Each background will have the same time, instead of splitting the 
backg 

 
Select “Same as Peak” as the “Background(s)” time. 
The background intensities will be counted for the same time as the 
peak intensities. 
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In the next step, we will look at the lines that were chosen by SPECTRAplus for inclusion 
in our Measurement Method. If we wanted to pre-select the lines so we could have a 
mix of “High Resolution” and “High Sensitivity” lines, we could have done this step 
before doing the “Lines Selection” step on page 3-36. The only thing we would need to 
do differently in the “Lines Selection” step would be to NOT CHECK “Reset All”. 

1 

6

2 

3 

7

5

4 
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 Click on the Lines tab to select it. 

 Click on the drop-down arrow by “Element” and select “Cr” from the list of 
elements. 

Note that Cr uses a “High Energy” line (K-alpha). The conditions are set 
“High Sensitivity” (HS) for a minor conce

to 
ntration (Min). Also, the line is a 

copy of the original line with the Material name (LAS-Example) appended to 
it. 

 Click on the drop-down arrow by “Element” and look at the other two lines. 
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 Click on the Modes/Time tab to select it. 

 Select the “LOCAL parameters for method” radio button. 
All lines will be measured the same. 

 Select the “Ni KA1 HS MIN” Line from the drop-down menu. 

 Select YES to select specific parameters. 

 
 Select the “Automatic” radio button in “Measuring Time”. 

This measurement will be counting to a set statistical error. 

 Select “30 s” as the maximum counting time. 
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 Click the Close button to exit the Measurement Method program. 

 
Click the Yes button to save the changes that were made to the Measurement 
Method file “LAS-Example.mm”. 
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3.6 Optimizing the Measurement Conditions 

In this step, the measuring conditions used for the lines will be checked and optimized. 
his will be done by measuring pulse height distributions to optimize the detector 
iscriminator setting nd 

background measu

T
d s, and by measuring 2-theta scans to optimize the peak a

rement positions. 

 

 Click th rameters. e Next button to move to Measurement Pa

 Click the Launch button to start the Measurement Parameters program. 
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 Click the drop-down arrow by the “Line” box, and select the 
“Cr KA1-HS-Min/LAS-Example” line from the list of lines shown. 

 

 The Spectrometer tab should be selected. This shows the instrument 
 that will be 

used to measure this line. Any of the conditions shown could be changed 
operating parameters, except for detector discriminator settings,

from this tab. 
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 Click on the Pulse Height Analysis tab to select it. 

 Enter the sample position where SS 404 was placed on the sample 
loader. 

 Click the Run button to start the measurement. 

 

The sample will now be transported into the spectrometer and measurement of an 
energy distribution will begin.  
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 This energy distribution will be for one detector only, as 
detector buttons (“FC” or “SC”). These buttons will only be en

selected by the 
abled if the 

corresponding detector is selected for this line. 

 The data will be plotted in real time as it is collected. The energy distribution 
should be centered approximately on the red line; if it is not, then the 
detector high voltages need to be reset. 

 The blue line shown below the energy distribution represents the detector 
discriminator settings, or “Lower-Level” (LLD) and “Upper-Level” (ULD). 
This should encompass all of the energies to be measured. 

 If the detector discriminator settings (blue line) need to be adjusted, move 
the mouse over the end of the blue line that needs to be adjusted. The 
mouse pointer will change to a horizontal double arrow. Click and hold 
down the left mouse button, then drag the mouse to move the end of the 
line. 

 

 

 

1 

2 

3 
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 Click on the Immediate Scan tab to select it. 

 Click the Run button to start the measurement. 
 

he ak angle is 
curr
theoretical position. 

To s  the current position 
until it changes to a horizontal doubl
mouse button, then drag the mouse to move the position of the line. 

 The short vertical blue line(s) represent where the background intensities 
will be measured. 

T  tall vertical red or green line represents where the pe
ently set. Red means a user-set position, and green means a 

 et the peak angle, move the mouse pointer over
e arrow. Click and hold down the left 

 
If there is more than one background position set, all but one should be 
removed. To do this, move the mouse pointer over the line to remove until 
the mouse pointer changes to a horizontal double arrow. Click and hold 
down the left mouse button, then drag the line to the Trash Can located in 
the lower right corner of the window. 

 
If there are no background positions set, then one should be set. To do this, 
move the mouse pointer over the New background icon in the lower right 
corner of the window. Click and hold down the left mouse button, then drag 
the mouse to position the background as indicated in the diagram below. 

 To move the background position to a new location, move the mouse 
pointer over the current position until it changes to a horizontal double 
arrow. Click and hold down the left mouse button, then drag the mouse to 
move the position of the line. 
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 Click the drop-down arrow by the “Line” box, and select the 
“Mn KA1-HS-Min/LAS-Example” line from the list of lines shown. 

 

 

 Click the “Write Changes in Library” radio button to select it. 

 Click the OK button to save the changes that were made. 
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 Click on the Pulse Height Analysis tab to select it. 

 The Run button should still be depressed, and the measurement 
should start; if not click the Run button. 

 Set the discriminator settings to bracket the energy distribution for Mn. 
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 Click on the Immediate Scan tab to select it. 

 The Run button should still be depressed, and the measurement should 
start; if not, click the Run button. 

 Set the peak angle and a single background position, as shown below. 
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 To i -Line, click on the 
Identify Lines icon, then move the mouse pointer over the peak. 

 A w  the mouse pointer’s position. 

 

dentify the peak seen to the low angle side of the Mn

indow will open, showing the lines around

 

 

 

 

 Click the drop-down arrow by the “Line” box, and select the 
“Ni KA1-HS-Min/LAS-Example” line from the list of lines shown. 

 Click the “Write Changes in Library” radio button to select it. 

 Click the OK button to save the changes that were made. 
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 Click on the Pulse Height Analysis tab to select it. 

 The Run button should still be depressed, and the measurement should 

 Set the discriminator settings to bracket the energy distribution for Ni. 

start; if not, click the Run button. 
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 Click on the Immediate Scan tab to select it. 

 The Run button should still be depressed, and the measurement should 

Set the peak angle and a single background position, as shown below. 

start; if not, click the Run button. 

 

 

 
  

 Select the “Cr KA1-HS-Min/LAS-Example” line. 

 Click the “Write Changes in Library” radio button to select it. 

 Click the OK button to save the changes that were made. 
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Line Low 
Sample 

High Sample 

Mn KA1
Example

SS 403 -HS-Min/LAS- SS 402 
 

Cr KA1-HS-Min/LAS-Example SS 402 SS 403 

Ni KA1-HS-Min/LAS-Example SS 402 SS 403 

Table 1 - Drift correction samples for LAS-Example Measurement Method 

 

 Select the Drift correction tab. 

Check that there are two reference samples listed. 

In some cases, the “drift correction samples” may be deleted from a line. This occurs if 
changes are made in the conditions used to measure the line, or significant changes 
are made in the discriminator settings. 

If the Cr line does not have both “drift correction samples” listed, then: 

 Click the New button. 
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 Enter the name of the missing sample. 

 Click the OK button. 

 Switch to the “Mn KA1-HS-Min/LAS-Example” line and check the 
“Recalibration Samples” for it. Add back any missing ones. 

 

 

 Swi  check the 
“Recalibration Samples” for it. Add back any missing ones. 

tch to the “Ni KA1-HS-Min/LAS-Example” line and

Click the Close button to exit the MeasParameters program.  
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 If measurements are still running, a message indicating that these will be 
interrupted will be given. Click the OK button to stop the measurements and 
unload the sample. 

 

 

If any changes made have not been saved, the following window will be shown: 

 Click the “Write Changes in Library” radio button to select it. 

 Click the OK button to save the changes that were made. 
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3.7 Measuring the Calibration Standards 

In this step, intensities will be measured on the five low-alloy steel calibration standards. 
Although the “Recalibration”, or “Drift Correction”, samples are the same as the 
“C libration l 
measureme ured will be 
stored in “Step Scan Data” files (“*.ssd”) in the folder 
“\SPECplus\Libraries\Materials\LAS-Example\Solid”. 

 

 

a  Standards,” the names used for them are different so an additiona
nt needs to be made for them. The intensities that are meas

 Click the Next button to move to Measurement Standards. 

 Click the Launch button to start the Loader program. 

 

 

When the Loader program first starts, all positions are blocked and have “X’s” displayed in 
them. 
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After a brief time, the “X’s” will disappear, and any cups that were measured in the past 
will be spldi ayed on the Loader. Clear any cups using the following icons: 

 “Erase OK” cups. 

 “Erase Error” cups. 

 “Erase New” cups. 
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Click View on the menu. Make sure all options are checked, and arrange 
the windows as shown below, or to your individual tastes. 

 

 

 

 

Click the position on the Loader where the first calibration standard is 
loaded. 

 Select Standards→Import From Database from the menu. 
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 The “Material” should be set to “LAS-Example”. If not, use the drop-down 
control to change it. 

 The “Preparation” should be set to “Solid”. If not, use the drop-down 
control to change it. 

 The “Import Using Measuring Method” should be set to “LAS-Example”. If 
not, use the drop-down control to change it. 

 Click the Search From Database button. 

 

 

Material 

Preparation 

Measuring 
Method 
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 Make sure the standards are loaded in the order shown, and then cli
Import at Current Position button. 

ck the 

 

One sample holder per calibration standard should now be displayed on the loader. 

The measurement s
sample  are loaded rder; if not, reload them. 

You may notice a es not 
matter, so do not be too concerned about this. 

equence is displayed in the Sample Edit window. Make sure the 
 in this os

th t the Type of sample is set to “Bead” instead of “Bulk”. This do
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 ick the Send all Samples icon to start the measurements. Cl

 

 

 
All the sample holders should have “lock-down bars” displayed on them. 
These indicate that the samples are committed to be measured, but have 
not actually been queued into the measurement sequence yet. 

 

Sample Edit 
Window 
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After a brief time, the samples will be queued into the measurement sequence. This is 
indicated by icons being shown on the cups and in the Sample Edit window, and by the 
samples being listed in the Sample List window. 

The following icons can be displayed during the measurements: 

 
The sample is queued for measurement, but the measurement has not 
started yet. 

 A sample cup could not be found in this position on the Loader. 

 
The sample is being loaded into the spectrometer, or is in the pre-load 
chamber of the spectrometer. 

 
The sample is being measured. 

 
The sample has finished being measured, and the measurement was 
successful. 

 
There was an error during the measurement of this sample, and the 
measurement did not complete. 

 

After the first sample has finished being measured, a Duration and Time End will be 
displayed for the remaining samples. 

 

Sample List 
Window 
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All of the sample holders should have an “OK” icon displayed on them when 
all the measurements are finished. 

 Click the Close button to exit the Loader program. 
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3.8 Creating an Evaluation Model 

 

 Click the Next button to move to Evaluation Model. 

EDIT 

CREATE 
Click the Create button to create a default model. 

 Click on the Edit button to start the Model Setup program and edit the 
model. 
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 Click the Methods tab to select it. The names for each part of the 
analytical method can be

total 
 specified on this tab. 

 C ients are 
stored, which is developed in Section 3.10. 

Modules set: File where extended calculations are 
stored. This is not described in this guide, 
but can be found in the SPECTRAplus 
Reference Manual (M84-Exx025). 

 Format method: File where output format for results is 
stored. This is developed in Section 3.9. 

 User calculations: Program or batch file to be automatically 
started after SPECTRAplus has calculated 
and reported the results for each sample. 
These are typically used for transferring 
results to a user’s database, or for making 
specialized printouts. 

 Measurement method: File describing which X-ray lines need to be 
measured by the XRF instrument, and how 
to measure them. This was described in 
Section 3.5. 

alibration method: File where calibration coeffic
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 Click the Preparation tab to select it. 
The specimen preparation used can be fixed on this tab so that it does not 

 have to be given when measuring unknown samples.

 

Click the Elements Map tab to select it. 
The list of elements has been transferred from FQuant, and no further 
action is needed here. 
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 Click the Chemistry: Rules tab to select it. 
This can be used to indicate special rules when using the 
Standardless program, like matrix element, compound 
formulas, etc. 

 The Default Chemistry has been set to “Calibration 
ds”, becau ration 

to calculate sample 

 

Compoun se this example will use a formal calib
composition. 
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 Click the Optimization tab to select it. 
Aplus to show all This can be used to force SPECTR

concentrations including those with negative values, and those 
that are statistically insignificant. 

 

 Click the More rules tab to select it. 
er of iterations 

pecial chemistry rules. 

This can be used to change the numb
SPECTRAplus uses when calculating the composition of a 
sample, and other s
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FILE  

SAVE 

Click File→Save.  

Verify that you save into the Calibrations directory. 
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3.9 Creat

 

In this step, the format for printing 

ing a Results Format Method 

and displaying results will be specified. 

 Click the Next button to move to Results Formatting. 

 Click the Create button to create a default printout for the method. This will 
be enough to display the results the same way the standards were defined. 
It is not necessary to edit the format, unless it is desired to add more 
options. 

 Click Edit to modify the format. 
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The Material/Model tab button should already be selected. 
The information given in FQuant for our Material has been automatically 
transferred over. 
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 Click the Compounds/Elements/Names button to select it. 
This screen allows the user to select, on an element-by-element basis, 
whether to report the concentration as an “Element”, a “Compound”, or 

und 
n the context of 

mpound. Since the 

“Auto”. “Auto” reports the concentration as an element or a compo
based on a concentration threshold that will be set later. I
this example, “Compound” refers to a calibrated co
calibration will be done as “Elements”, compound and element mean the 
same thing. 
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It is also possible to rename one of the constituents so that it will be reported using a 
different name, for example: 

 Click on Ni to highlight it 

 Check the box to rename it. 

 

Type the new reporting name, or select the new name from the list of 
names given. 
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 Cl k
SPE
unit, 
defa
“PPM
This 
auto

ic  on the Unit Choice button to select it. 
CTRAplus uses two units for reporting concentrations. One is a “trace” 
which by default is set to ppm. The other is a “major” unit, which by 
ult is set to %. These default units can be changed by clicking on the 
” or “Percent” buttons. 

is also where the concentration threshold would be set to control the 
matic (“Auto”) switching between the major and trace units. 
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 Click on the Unit Selection button to select it. 
This is where the reporting units for each element can be specified. 

n be changed by clicking on the “PPM”, “Auto”, “Percent”, 
or “Delete” buttons to set all elem
elements g an element symbol to match its color 
to one of t

Whatever units were defined in Section 3.2 will automatically be set here. 
These settings ca

ents to the button selected. Individual 
can be changed by clickin
he buttons. 
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 Click on the Decimals button to select it. 
This is where the number of decimals to report can be given for each 
element. The decimals defined in Section 3.2 will automatically be set here. 

 The actual number of decima
element symbol. The number of decimals can be changed by clicking on a
element symbol. 

ls is indicated by white dots shown below the 
n 
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 Click on the Print Order button to select it. 
This is where the order in which to print the elements is given. The o
elements were added to the Material in Section 3.2 will automatically be se
here. 

rder 
t 

 Individual element symbols can be clicked to give a different order. 
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 Click the Modules/Input/Databases b

From here, additional information stored in the database 

utton to select it. 

“\SPECplus\Databases\Measure.mdb” can be added to the output. 
Results from a Modules calculation or manual inputs from a Sample 
Definition can also be added (see SPECTRAplus Reference Manual). 
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One of the u
Normally this is not displayed, but is good to have on reports so that it is clear how a sample 
was measured. To add this to the output: 

seful items to add from the Database is the “Measurement Method Name”. 

 Locate, then highlight MeasureMethod in the Database 
window.  

 Type “Method” in the “New name:” box to give this field a 
shorter name. 

 Click the Add to Output button. 

 

The Measurement Method will now be listed in the output under the heading of “Method”. 
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T ems in the output. he Up and Dn (Down) buttons can be used to reorder it

 

 

 Click the Settings button to select it. 

This screen provides options for special settings, such as: 
 - Replacing missing values with zeroes 
 - Moving the concentration units to the header, instead of putting them in 
the cell with the value 
 - Displaying the intensities 
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 Click the Print Layout button to select it. 
This screen allows giving options for the printouts, like page orientation, 
headers, etc. It also allows requesting automatic printouts after a fixed 
number of samples have been displayed. 
 
In this example, automatic printing will not be used. 

 Un-check the Automatic Printing box. 
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Click the Monitoring Layout button to select it. 
 
This screen is used to control the display of results on the monitor. 

 

Use the arrows to increase the Display number to its maximum value or 
999. 
This controls the maximum number of samples that will be displayed at 
any given time. 

 Highlight Sample in the field list window. 

 
Check the box to always display this column. This will keep the sample 
name on the screen when a long list of element concentrations is 
scrolled. 

 Click the Close button to exit the program. 
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in the Save In box. 
Make sure the directory is set to “\SPECplus\Libraries\MeasMethods” 

 “LAS-Example.wzm” should be in the File Name box. Enter it if 
not. 

it is 

 Click the Save button. 
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3.10 Calculating Calibration Coefficients 

 

In this section, ed in 
Section 3.7 will be regressed against the concentrations entered in Section 3.2.  

 

the intensities measured from the five calibration standards as outlin

 

 

  Click the Next button twice to move to Calibration Method. 

“LAS-Example” should be selected in the Material box. 

“Solid” should be selected in the Preparation box. 
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Material Specific Lines Only: Checked to use only lines with the Material name in 

Click Calibration on the menu, and set the options as shown. 

them (“/LAS-Example”). 

Enable Line Position 
Checking: 

Checked to make sure peak and background positions 
in the intensity data files match those stored in the Line 
Library. 

Disable Automatic 
Regression: 

Unchecked to automatically calculate the calibration 
coefficients as each element is visited. 

Click the Next button to move to Standard Samples.  

 

Five standard names should be listed with a check mark by their names. The column 
labeled “File” should have the word “Exist” for each sample. This means that the 
intensity data file was found. 
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Quantification Program 
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 Click the Next button to move to Compute Coefficients. 

 

 

The Calibration Toolbox should be displayed on the screen. If it is not, press the F2 
key to display it. This example shows “Cr” as the select element. Do not worry at this 
point which element is shown in your “Toolbox”. This toolbox is used to ask for different 
“views” of the data, like a graphical or tabular view. It is also used to move from element 
to element in the data set. 

Make the initial settings to the toolbox as shown below: 
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The “E” or “Element” button is pushed in to show calibration data as 
elements. The “C” or “Compounds” button should be pushed in when doing 
compounds. In this case, either button could be pushed in. 

 The “Show Graphical Display” button should be pushed in; a Close button is 
gh  
 w

displayed to the ri
data in a separate

t of it. This will show a graphical representation of the
indow. 

 The “Show
displayed

 Tabular 
 to the righ

data in a separate w

Display” button should be pushed in; a Close button is 
t of it. This will show a tabular representation of the 
indow. 

 The “Sh
should 

ow Compari
not be displa

son” button should not be pushed in; a Close button 
yed to the right of it. 

 The “%” button shou
percent instead of ppm. 

ld be pressed in to display the concentrations in 

 Click the “Show/Hide Additional Tools” arrow in the lower right corner to 
expand the Calibration Toolbox. 
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 The se button is 
displayed to the right of it. This will show a tabular representation of the 
data in a separate window. 

 “Show Tabular Display” button should be pushed in; a Clo

 The “Show Overlaps” button should be pushed in; a Close button is 
displayed to the right of it. This will allow adding and removing of “spectral 
overlap” corrections. 

 The “Show Internal Standard” button should not be pushed in; a Close 
button should not be displayed to the right of it. No “internal standards” are 
used in this method. 

 The “Show Coefficients” button should be pushed in; a Close button is 
displayed to the right of it. This will allow disabling the default “matrix” 
corrections from the calibration. 

 The “Show Summary” button should be pushed in; a Close button is 
displayed to the right of it. This will show a summary of the calibration data. 

 The “Minimize the Absolute Errors” button should be pushed in. This will 
make the regression program try to minimize the “absolute” errors between 
the calculated concentrations and the given concentrations. 

 The “Use Net Intensities” button should be pushed in. In this example, we 
want to subtract the background intensity from the gross peak intensity. 

 Click the “Show/Hide Additional Tools” arrow in the lower right corner to 
contract the Calibration Toolbox. 
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Note: As the icon buttons are pressed, requesting different views of the data, tabs will 
appear on the bottom of the main window. Switching to a different view can now be 
accomplished by clicking a tab on the bottom of the screen, or on the icon that opened 
that tab. Closing a view can be accomplished by clicking the Close button (“X”) to the 
right of the appropriate icon. 
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Using the Element Symbol control in the Toolbox, we can move from
element to element with

 
in the data. 

 The Forward arrow moves to the next higher-atomic-number element 
in our list. 

 The Back arrow moves to the next lower-atomic-number element in 
our list. 

 The dark arrow to the right of the Element Symbol displays a periodic 

 

table that enables selection of any element in our list. 
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 Using the Line Symbol control in the Toolbox, we can select which line 
to calibrate if multiple lines were measured. This example only 
measured one line per element. 

 The Forward arrow moves to the next line in our list of lines. 

 The Back arrow moves to the previous line in our list of lines. 

 The dark arrow to the right of the element symbol displays the list of 
possible lines for calibration. 

 SPECTRAplus can be calibrated for up to three lines per element. Using 
the numeric control, we can designate each line as the default, 
secondary, or tertiary line. Our line should be designated as the primary 
line, so the “#1” should be pushed in, and its color should be red. 

 

 

 Select the Graphical Display tab. 

Check that C XRF is displayed on the right. 
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Quantification Program 
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 Expand the window to full screen. 
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 S lee ct the Tabular/Standards display and expand it to full screen. 

 

 

 Select the Eyeglass button. 

Select the following columns to be displayed: Number, Standard Name, 
Chemical C, XRF Conc, Abs dev, Rel Dev, Gross Int, Background, Net 
Intensity, LLD. 
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 Activate Offset, check out the Standard deviation displayed. 

 

 
 Compare the XRF with the Chemical Concentration in the Standards 

display. 
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 Select the Compare button, which shows you the function which logs the 
progress and all settings for each step performed so far. 

Change from NET to GROSS on the Toolbox and see how it impacts the 
standard deviation displayed, change the regression weight from abs to 
relative and observe. At the end, switch back to NET and Active Offset. 

 

 

  

Select the Line Overlay tab. 
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 Select 10 for Influence Range. 

4     2/05 

Select 0.1% in standard samples as minimum concentration. 

Select 1-2 for Reflection Order. 

Press the first “???” button to have SPECTRAplus search for line overlaps on 
this line. 

Change the range to 30 and press the “???” button again. 

 Select CALC and observe the Standard Deviation in the Toolbox. 
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1 

Select the Alphas tab. By default, VARIABLE alphas are selected (the best 
option). 

 
 Change from variable to fixed alphas (theoretical) by pressing the Fixed 

Alphas button. 
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 Select No Correction. 

 
 Select Variable Alphas.  
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 Select the Summary tab. 

 
 Select Print Preview and print the documentation for this line. 
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 Select Mn from the Toolbox Element button and perform the same steps as 
for Cr. 
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 Select Ni from the Toolbox element button and perform the same steps as 
for Cr. 

 
 Save the calibration. 
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3.11 M

 

Select the Loader from the Desktop folder. 

Select an available position on the Loader grid, where the drift correction 
samples will be placed. 

Press the Drift Correction button, or select Standards→Drift correction.  

Select “LAS-Example”. 

The designated drift correction samples are shown in the list. 

Select Import to import the shown samples onto the Loader. 

 

easuring the Drift Correction 
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 Press the Send All Samples button. 

 Wait for all samples to be measured. An OK flag indicates that the drift 
correction was stored. No concentrations will be displayed for drift corrected 
samples. 
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 Select the Libmanager application from the SPECPLUS folder on your 
Desktop. 

 Sort for Extension name and click on a LAS –example line. Inspect the drift 
data. Validate that an entry was created for correction data by checking DC 

the measurement. 
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3.12 Measuring Sample as Unknown 

→Definition File. 

 

 Select Loader. 

Select Samples

 

 

 

 Select “Routine-vac.def”. 
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 Right-click on any tab of the Sample Edit window to remove the tab. 

 

 

 Right-click on the position where you placed a sample and select Edit. 
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 Enter the sample name and select the “LAS-Example” Method from the 
drop-down menu under “Method”. 

 

 

 If a Sample Type column is shown, select Bulk. 
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 Repeat procedure until you have entered all 5 samples. 

 

 

 Send All Samples and look at the results. 
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 Select the Results Monitor. 

 

 

From the Mapping List, select the “LAS-EXAMPLE” by clicking on the down 
arrow. 

 

 Select File→New Monitoring View. 
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 Click on the table with the Gears icon to update the view. 

t n results (as set 
in the Monitoring section of the Results program) for the selected format. 
In this view (Monitoring), SPECTRAplus will display the las

 

 

 Click on a column header to change the sort order, e.g., for sorting by date. 
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